
SAS Learning Edition is an educational tool, not intended for commercial use.  
 
The product license will be good until December 31, 2006.  
The product will process 1000 observations.  
Limited product support is available via the SAS Learning Edition Web site 
(www.sas.com/LE) and the book and interactive tutorial included with the product.  
Suggested retail price is $125.  
 
System Requirements: 

 Microsoft Windows 95, 98, NT 4.0, 2000, Me or XP 
 390 MB hard disk space 
 64 MB RAM minimum 
 web site info: http://www.sas.com/le 

 
product = SAS Learning Edition 
    008702 "Cannot create a copy of the datasource" error message appears when 
           installing, invoking, or performing tasks in SAS Learning Edition 
    Component:  General Product Issues 
    Release(s) Reported: 1.0 
    Release(s)    Fixed: 
    SN     http://support.sas.com/techsup/unotes/SN/008/008702.html 
 
 
===================================================================================== 
What Proc SETINIT provides for SAS LE 
 
NOTE: PROCEDURE SETINIT used: 
      real time           0.10 seconds 
 
Original site validation data 
Site name:    'The SAS Learning Edition V1.0'. 
Site number: xxxxxxxx. 
Expiration:   31DEC2006. 
Grace Period:  0 days (ending 31DEC2006). 
Warning Period: 0 days (ending 31DEC2006). 
System birthday:   01JAN1989. 
Operating System:   WIN     . 
Product expiration dates: 
---Base Product                                            31DEC2006 
---SAS/STAT                                                31DEC2006 
---SAS/GRAPH                                               31DEC2006 
---SAS/ETS                                                 31DEC2006 
---SAS/QC                                                  31DEC2006 
---SAS/Learning Edition                                    01JAN2007 
---SAS/Learning Edition - Expanded                         11JAN1960 
 



 
      
I don't know if you've already gone through this exercise, but this is    
my list of what PROCs appear to be included in the Learning Edition:   
Dave      
dkb@cix.compulink.co.uk     
      
      
Base Procedures:  SAS/GRAPH: SAS/STAT:  SAS/ETS:  SAS/QC:   
      
APPEND yes GANNO yes ACECLUS no ARIMA yes CAPABILITY yes 
CALENDAR no GCHART yes ANOVA yes AUTOREG yes CUSUM no 
CATALOG no GCONTOUR yes BOXPLOT yes COMPUTAB no FACTEX no 
CHART no GDEVICE no CALIS no DATASOURCE no ISHIKAWA no 
CIMPORT no GFONT no CANCORR yes EXPAND yes MACONTROL no 
COMPARE yes GIMPORT no CANDISC no FORECAST yes OPTEX no 
CONTENTS yes GKEYMAP no CATMOD no LOAN no PARETO yes 
COPY yes GMAP yes CLUSTER yes MDC no RELIABILITY no 
CORR yes GOPTIONS yes CORRESP no MODEL no SHEWHART yes 
CPORT no GPLOT yes DISCRIM yes PDLREG yes   
DATASETS yes GPRINT no FACTOR yes SASECRSP ?   
DBCSTAB no GPROJECT no FASTCLUS yes SASEFAME ?   
DISPLAY no GRADAR yes FREQ yes SIMLIN no   
EXPLODE no GREDUCE no GAM no SPECTRA no   
EXPORT yes GREMOVE no GENMOD no STATESPACE no    
FORMAT yes GREPLAY no GLM yes SYSLIN no   
FORMS no GSLIDE no GLMMOD no TSCSREG yes   
FREQ yes GTESTIT no INBREED no VARMAX no   
IMPORT yes G3D yes KDE no X11 no   
MDDB no  G3GRID yes KRIGE2D no X12 no   
MEANS yes  LATTICE no    
OPTIONS yes  LIFEREG no    
OPTLOAD yes  LIFETEST yes    
OPTSAVE yes  LOESS no    
PLOT yes  LOGISTIC yes    
PMENU no  MDS no    
PRINT yes  MIXED no    
PRINTTO no  MODECLUS no    
PRTDEF yes  MULTTEST no    
RANK yes  NESTED no    
REGISTRY yes  NLIN yes    
REPORT yes  NLMIXED no    
SORT yes  NPAR1WAY yes    
SQL yes  ORTHOREG no    
STANDARD yes  PHREG yes    
SUMMARY yes  PLAN no    
TABULATE yes  PLS no    
TIMEPLOT no  PRINCOMP yes    
TRANSPOSE yes  PRINQUAL no    
TRANTAB no  PROBIT no    
UNIVARIATE yes  REG yes    



  RSREG no    
  SCORE no    
  SIM2D no    
  STDIZE no    
  STEPDISC no    
  SURVEYMEANS no    
  SURVEYREG no    
  SURVEYSELECT yes    
  TPSPLINE no    
  TRANSREG no    
  TREE yes    
  TTEST yes    
  VARCLUS no    
  VARCOMP no    
  VARIOGRAM no    
 
 
I can also confirm that the Data Step Graphics Interface and the Graphics Editor are both included in the 
SAS LE version of GRAPH. 
Dave



Messages about SAS LE from SAS-Lers: 
 
11 
12   data sasuser.test; 
13     do i = 1 to 10; 
14     output; 
15     end; 
16   run; 
 
NOTE: The data set SASUSER.TEST has 10 observations and 1 variables. 
NOTE: DATA statement used: 
      real time           0.05 seconds 
 
When I go into LIB window and try to open up SASUSER.TEST this is the error I get 
 
ERROR: Module SASZAF   not found in search paths. 
 
 
Regards, 
Charles Patridge 
PDPC, Ltd. 
172 Monce Road 
Burlington, CT 06013 
=========================================================================== 
 
Date: Sun, 14 Jul 2002 06:29:43 -0700 
 From: Roger DeAngelis <xlr82sas@AOL.COM> 
 Subject: Re: More on: Re: SAS LE - restrictions related to front end Enterprise 
Guide 
  
SAS LE does not color code SAS statements, at least by default, in the old 'prefix 
area, ispf like' editor. Full 8.2 version does. I am not talking about the enhanced 
editor. 
 
 xlr82sas@aol.com (Roger DeAngelis) wrote in message  
 Using the free SAS viewer with LE 
  
 If you type "svu Libref.Table" on any command line in SAS LE then the 
 table will be viewable. (more checking should be done in macro) 
  
 %Macro Svu ( arg ) / cmd des="Command line SAS viewer for LE"; 
 /*------------------------------*\ 
 | usage: svu libref.table | 
 \*------------------------------*/ 
 %Local Loc; 
 %If %index(&arg,%str(.)) = 0 %Then %Do; 
 %Let Loc=%qSysfunc(Pathname(work))\&arg..sas7bdat; 
 %End; 
 %Else %Do; 
 %let Loc=%Sysfunc(pathname(%qScan(&arg.,1,%str(.))) 
 )\%qScan(&arg,2,%str(.)).sas7bdat; 
 %End; 
 x "sv %Unquote(&Loc)"; 
 %Mend Svu; 
  
 ===================================================================== 
 xlr82sas@aol.com (Roger DeAngelis) wrote in message  
 I just installed SAS-LE on my Win XP system ( dual monitors are nice ) looking at 
SAS on the right monitor as I type. 
  
 1. Funny Icon black square with stars and a white telescope appeared. 



  
 2. Clicked on the icon and got something that looks like Visual Basic demanding that 
a start a project (immediately closed SAS down ). 
  
 3. Did a search to find out where sas.exe was and built a shortcut. 
  
 4. added -sasuser x:\xx -work x:\xx -sasautos x:\xx -nosplash 
  
 5. clicked on new icon, set my options ( disabling most 'default features') when I 
had the largest blank screen possiple I turned on prefix area, command line, autosave 
every 3 minutes, save 30 events 
 Every thing seems ok. 
  
 6. Ran Proc Setinit 
 Stat,Graph,ETS,QC and LE stuff appeared license good through 2006 
  
 7. Tried to view sashelp.table got the same error Charles got!! 
  
 ERROR: Module SASZAF not found in search paths. 
 Perhaps I can call the free SAS viewer programatically 
  
 8. Tried to find viewtable using EGG ( Enterprise Guided Guidance ) but layed an 
EGG. In spite of the wizard and 100 clicks of the mouse. In all fairness the 
interface is quite intuitive and initially seems better than Microsofts VB interface. 
For a newbie the interface is fine. 
  
======================================================================  
 tchur@OPTUSHOME.COM.AU (Tim Churches) wrote in message 
 Tim Churches wrote: 
  
 Charles Patridge wrote: 
 It seems when using SAS DM and bypassing Enterprise Guide, I am unable to open 
(viewtable) a SAS Dataset - get an error SASZAF not found in search path. 
  
 What about the converse - using SAS LE Enterprise Guide (I'll call this Enterprise 
Guide LE henceforth) but ignoring the rest of SAS LE? 
  
 Do there seem to be any impediments there? Enterprise Guide is basically a menu-
driven facility for writing SAS code. I wonder if SAS LE complete with Enterprise 
Guide LE could be pointed at an ensemble of sampled datasets with the same structure 
as some full datasets and Enterprise Guide LE used to write code which is then run 
using full SAS against the full datasets. Possible? There is no 1000 obs limit in the 
**code** which Enterprise Guide LE generates, right? 
  
 I only ask because the cost of the perpetual (or at least multi-year) SAS LE license 
is about one third of the cost of an annual Enterprise Guide (only) license as quoted 
to us last year... 
  
 After writing this, I read Steve Albert's post: 
  
 I'd like to remind people that the SAS/LE license agreement states that the product 
is not licensed for commercial production use. And by the way, this is not a "shrink-
wrap" agreement; you need to acknowledge reading and accepting it during the 
installation process, or SAS/LE won't install. 
  
 I suspect that rather resticts the utility of the idea outline above. However, I can 
still see some prospects for using SAS LE in this way. 
  
 For example, governmental health departments might want to provide post-graduate 
health research students with access to datasets, but can't give them direct access 
due to confidentiality and other restrictions. The research students could however be 



given access to a set of datasets with  identical structure and metadata to the real 
datasets, but containing only 1000 synthetic observations. The students could use SAS 
LE complete with Enterprise Guide to write their SAS code, then email that code in to 
the health dept where the code would be run against the full datasets using a full 
versions of SAS, and the (aggregate) results sent back to the students. Human 
intervention would be needed to check that the results really were aggregated, but at 
least debugging (or complete re-writing) of the SAS code submitted by the students 
would be unnecessary. 
 Tim C 
======================================================================== 
Charles, 
 
A few points arising from my first hour of getting SAS LE up and  
running: 
 
Like Kenneth Moody, I found the install hung while it was configuring the SAS 
Registry. I think this problem arises because, although it apparently allows you to 
specify your own directory names, part of the install software isn't reading what's 
been entered. Reinstalling and taking all the defaults worked OK. 
 
Like Roger DeAngelis, I got the Enterprise Guide at first, shut it down and created 
my own shortcut to "real" SAS. I feel the install should create an EG shortcut and a 
normal SAS shortcut. 
 
The install process says that it's installing Integration Technologies, and a 
directory is created with that name, but the documentation doesn't seem to be linked 
in properly. 
 
On the subject of the 1000 obs limit, as has been pointed out it's possible for data 
steps to create bigger datasets. It's also possible for them to read bigger datasets: 
with a WHERE clause, the 1000 limit  
comes in after the condition is applied, not before. (I haven't yet checked whether 
PROCs work the same way.) 
 
But even if it's a very cut down version with a few quirks, it's useful for an out-
of-work contractor like me to have a version that doesn't cost thousands of pounds to 
license. :) 
 
Best regards, 
 
Dave 
dkb@cix.compulink.co.uk      
 



Charles, 
 
Good questions, I appreciate being able to get this info out there. Please see my responses below. 
 
- Bernard 
 
-----Original Message----- 
From: Charles Patridge [mailto:CHARLES_S_PATRIDGE@prodigy.net]  
Sent: Thursday, July 18, 2002 12:15 PM 
To: Bernard Penney 
Cc: charles_s_patridge@prodigy.net 
Subject: More questions for SAS LE 
 
 
Hello Bernard, 
 
I came up with some more questions on SAS LE. 
 
1. Will version 1.0 continue to have an expiration date of Dec 2006 no matter when it is sold? That is,  
if I bought another version of SAS LE a year from now, will the expiration date still have Dec 2006? 
 
<< Version 1 of the SAS Learning Edition will always expire on Dec 31, 2006, regardless of the purchase 
date. This is to give customers about 4 years in which to use it without having to worry about renewals. It 
also makes sure we do not have old, obsolete, versions floating around out there. Sometime before 
12/31/06 we will come out with a new version of the LE, which will be good for four years+ from that 
release date. >> 
 
2. What will happen in Dec 2006 when SAS LE version 1.0 expires? Would I have to request / pay 
another $125.00 to have a new SETINIT mailed to me or would I have to go and buy another new version 
of SAS LE to get another 4 years of testing/learning SAS LE? 
 
<< There are no renewals, so after 4 years, a customer would have to buy a new version, and get a much 
newer product! >> 
 
 
3. Should I decide not to keep my current version of SAS LE (version 1.0), can I get a refund? What is the  
process of getting a refund, if any is allowed?  Or, if I remove it from my PC, can I sell it to another 
person so that new person can install it on their PC? 
 
<< According to the license agreement, you can always return the LE for a refund if you have not already 
fully installed it on your system. >> 
 
I remember when I installed my version of SAS LE, there was no registration process to let SAS Institute  
know that I was the owner of XXXXXXXXXXX version of SAS LE. 
 
I was thinking of raffling off my copy of SAS LE at our next HASUG meeting in August but I did not 
want to violate any copyrights of SAS nor did I want the new owner to experience any bad circumstances 
with SAS LE ownership rights. 
 



<< Giving or raffling the LE should be fine >> 
 
4. Do you anticipate any new enhancements to SAS LE to include all BASE SAS modules such as PROC 
Calendar, FORMS, PRINTTO, CIMPORT, CPORT, etc etc? If so, when?  Also, it would be really nice to 
be able to open/view a SAS Dataset with Display Manager instead of using Enterprise Guide (for us 
current users of the full blown product of BASE SAS). 
 
<< We will continue to develop and enhance the SAS Learning Edition. We will never include ALL of 
the Procs of Base SAS. (there are 450 of them!) It is not the intention of the Learning Edition to replace 
Base SAS. If a user needs all Procs, then they need to purchase full Base SAS. The Learning Edition is 
strictly a personal learning version of SAS. With that said, if there are additional individual Procs that 
would be useful for learning SAS then we will certainly consider including them in the next release. >> 
 
Thanks for your response, 
Charles Patridge 
PDPC, Ltd. 
172 Monce Road 
Burlington, CT 06013 
Email: Charles_S_Patridge@prodigy.net 
 
From:         Kevin Myers <KevinMyers@AUSTIN.RR.COM> 
Subject:      Re: SAS LE (Re: Confused on the implementation of the 1000 row 
              limit              on SAS tables) 
 
Amen on the syntax checking!!!  Been using it a lot for that myself.  That's the ONE 
thing that I have found so far which LE is reasonably useful for! 
:-) 
 
But, at least for the kinds of stuff that I am involved with, LE is almost useless 
even for just demonstrating presentation capabilities. :-( 
 
BTW, one other MAJOR complaint so far besides the 1000obs limit:  No  
Viewtable???!!!   
 
Kevin M. 
 
----- Original Message ----- 
From: <dkb@CIX.COMPULINK.CO.UK> 
Newsgroups: bit.listserv.sas-l 
To: <SAS-L@LISTSERV.UGA.EDU> 
Sent: Sunday, July 21, 2002 2:39 PM 
Subject: Re: SAS LE (Re: Confused on the implementation of the 1000 row limit on SAS 
tables) 
 
> Kevin, et. al., 
> 
> After my first week looking at the software, IMO the bottom line is simply this:  
SAS LE, so called, is the "lite" version of Enterprise Guide, not the "lite" version 
of SAS at all.  To its target market, the 1000 obs limit is not really significant: 
the presentation layer rather than the data crunching is what it's intended to 
demonstrated. 
> 
> It's disappointing to us old hacks not to have something more fully featured, but 
it's a big step for the Institute to offer anything like this at all.  At least now I 
can syntax check my suggestions to SAS-L while I'm not on contract.  :) 
> 
> Kind regards, 
> Dave 
 
From:         Kevin Myers <KevinMyers@AUSTIN.RR.COM> 



Subject:      Re: SAS LE (Re: Confused on the implementation of the 1000 
              rowlimit on SAS tables) 
 
Just a few additional comments, see below... 
 
"Puddin' Man" <pudding_man@lycos.com> wrote: 
<snip> 
 
> Make no mistake about it, running a Software House is a _Business_. It is not 
reasonable to expect SI to do anything that might diminish their revenue/profits. I 
suspect there are a scant few 'shops' that can do at least a little *real* work with 
<= 1000 records. 
> 
> As near as I can tell, the SI objectives for LE are roughly as follows: 
> 
>   a.) To field a product which minimizes the potential for supplanting SAS products 
priced at ordinary license fees. 
>   b.) To hustle Enterprise Guide (and other normally 
>       priced SAS products). 
>   c.) To placate the folks that have urged them to 
>       release a low priced product. 
 
I completely agree that it isn't reasonable to expect SAS to do anything that might 
*diminish* their revenue.  But I think they are failing to adequately consider the 
flip side of the coin:  A more useful version of LE would *increase* their revenues 
because: 
 
1. Many more folks would take a look at LE in particular, and SAS in general, than 
will otherwise ever do so. 
2. Many more folks would license a SAS product (even if just LE) who will NEVER 
license ANY SAS product at all otherwise. 
3. Many more folks would become familiar with SAS, and recommend both LE and the full 
SAS system to others. 
4. A much larger number of people who know something about SAS or have at least heard 
of it would make SAS seem like a much more viable product in the marketplace, and 
less of a specialized niche product that is ***losing ground*** to the likes of 
Microslop. 
5. A more useful version of LE could be licensed for more money. 
 
Of course I'm certainly not proposing that SAS should completely eliminate all 
restrictions on the components that are included in LE and how it can be used.  I'm 
just suggesting that the 1000 obs limit is far too small to realize the maximum 
benefits that they *could* obtain if LE was released with more reasonable 
limitations, such as increasing the obs limit to at least 100K. 
 
By the way, I was looking at my setinit info for LE, and I noticed that there is an 
entry for an EXPANDED version of LE that is disabled by the regular LE install.  So, 
perhaps the SI folks have already done some thinking along these lines.  I hope so, 
and am keeping my fingers crossed.  I think that they should give away the current 
version of LE for free as a trial/demo version.  Then they could have this Expanded 
version of LE ("Personal Edition?") with more realistic limits for personal and 
educational use, and license that for something on the order of $500. 
 
 
From:         Kevin Myers <KevinMyers@AUSTIN.RR.COM> 
Subject:      Re: SAS LE (Re: Confused on the implementation of the 1000 row 
              limit              on SAS tables) 
Comments: cc: John Whittington <John.W@MEDISCIENCE.CO.UK> 
 
John - 
 
In some ways you are correct in interpreting my perspective, but I wonder if you may 
have missed part of my point.  I believe that most folks who might be interested in 
trying LE would do so because they have a real problem at hand that they want to 
solve.  But, they are individuals and small businesses who initially can't afford the 
very significant cost of SAS system components, without having more than a trivial 
trial license period to learn about all of the many things that SAS can do.  Folks 
like this would be willing to make a reasonable initial investment in something that 



might be able to do a little bit of real work for them, but NOT for something that is 
so crippled that it's almost worthless and can't even compete with standard office 
productivity software. 
 
SAS is far too big with way too many different components and capabilities to learn 
quickly.  And people learn best by being able to try something out on their own real 
data.  LE is so crippled with the 1000 obs limit that you can't even work with a 
reasonable data subset for any kind of real problem that would be worth using SAS 
for.  People won't be willing to spend the time that is necessary to learn SAS when 
they can't use it in a manner to see if it will really meet their needs. 
 
I could be wrong, but it seems likely to me that one of the reasons SAS introduced LE 
was probably in an attempt to get more people familiar with their product, so that 
more folks would be likely to carry that knowledge into work with them, and recommend 
it to their companies, also to keep it in front of more people, and thereby to 
promote SAS as a widely known and popular product.  But IMHO, they are going to fall 
far short of that goal with LE as currently released, because it isn't a useful 
enough product as is to encourage folks to really give it a try. 
 
Of course you could theoretically use LE in a pure classroom environment, but I think 
that the 1000 obs limit is going to prove extremely restrictive even there.  When you 
start trying to deal with various SAS procs that support CLASS variables, BY 
variables, and other types of grouping criteria, you are going to very quickly run 
short of enough data to form reasonable samples for statistical analysis (esp 
multivariate) and for creating graphics (e.g. PROC GPLOT with multiple overlaid 
curves).  It is also completely inadequate for teaching programming efficiencies and 
data management techniques.  After all, what university stat professor is going to 
sick his students on a product that can't even analyze a reasonable subset of the 
data that he is using for his studies?  Of course trying to subset data to form a 
realistic sample is always a major problem in its own right too.  And the smaller 
subset that you must form, the more difficult it often is to insure that the subset 
is realistic. 
 
So, yes you are correct that I am thinking of LE as both a demo and promotional aid, 
not simply a "learning tool".  And IMHO if SAS isn't thinking that way too then they 
are really missing the boat.  And, as outlined above, I don't think that LE is really 
even adequate as a learning tool with the 1000 obs limit in place. 
 
Hope this may better explains a little bit of where I am coming from. 
 
BTW, sometimes I word things in a way that comes on too strong.  Please forgive me if 
that is the case here.  When I have a strong opinion about something, it tends to 
come through, sometimes too much so.  I would just really like for SAS to do well 
with this product, and to provide something that will strongly encourage much more 
widespread SAS knowledge and usage. 
 
Kevin M. 
 
----- Original Message ----- 
From: "John Whittington" <John.W@MEDISCIENCE.CO.UK> 
Newsgroups: bit.listserv.sas-l 
To: <SAS-L@LISTSERV.UGA.EDU> 
Sent: Saturday, July 20, 2002 7:51 PM 
Subject: Re: SAS LE (Re: Confused on the implementation of the 1000 row limit on SAS 
tables) 
 
> At 17:18 20/07/02 -0500, Kevin Myers wrote: 
> 
> >P.S. - Being a 20 year veteran SAS user and consultant, a former SAS employee, and 
a Certified SAS Developer, of course I realize only too well that SAS has all sorts 
of great features and capabilities that products like Excel and Access can't even 
remotely begin to compete with.  But it's very difficult to show someone else what a 
great product SAS really is when you can't get 'em past the initial 1000 obs limit 
stumbling block imposed by LE! 
> 
> Kevin, again it seems to me that you are thinking of LE as a 'demo', or even 
perhaps a 'promotional aid', rather than as a 'learning edition'. 
> 
> Kind Regards 



> John 
> ---------------------------------------------------------------- 
> Dr John Whittington,       Voice:    +44 (0) 1296 730225 
> Mediscience Services       Fax:      +44 (0) 1296 738893 
> Twyford Manor, Twyford,    E-mail:   John.W@mediscience.co.uk 
> Buckingham  MK18 4EL, UK             mediscience@compuserve.com 

 
From:         Tim Churches <tchur@OPTUSHOME.COM.AU> 
Subject:      Re: SAS LE (Re: Confused on the implementation of the 1000 row 
              limit on SAS tables) 
Comments: To: John Whittington <John.W@MEDISCIENCE.CO.UK> 
 
John Whittington wrote: 
> At 17:07 20/07/02 -0500, Kevin Myers wrote (in small part): 
> 
>> Personally, I sure think that SAS should do something more along the lines of 
Oracle's (free!!!) Personal Edition.  ....... Unfortunately, I don't think that SAS 
is really going to accomplish very much at all with a product that is limited to only 
reading 1000 rows at a time.  There just aren't going to be enough folks out there 
who will be willing to take the time to "play around" with SAS such an unusable 
level, especially if they are going to have to spend any money to do so. 
> 
> Kevin, I've been following this thread with interest, and it seems to me that many 
of the participants are critising and judging it as something other than a 'learning' 
edition. 
 
I've also been following it with interest. I agree that SAS LE is intended as just 
that - a learning edition, but I am forced to ask myself, learning what, exactly? 
 
The 1000 obs limit makes it unsuitable for learning about statistical analysis - many 
pedalogical datasets these days are bigger than 1000 obs. 
 
Similarly the 1000 obs limit severely limits its use in teaching data management and 
data warehousing techniques. 
 
So it seems that its main use is in learning about how to write the proprietary SAS 
syntax - data step and proc code, macros etc. Which is fine, but why then does it use 
Enterprise Guide as its default interface - one which shields the user from SAS code 
(and writes it for them).  Unsurprisingly, it seems like the SI marketroids haven't 
really thought this through. 
======================================================================= 
From:         Tim Churches <tchur@OPTUSHOME.COM.AU> 
Subject:      Re: SAS LE (Re: Confused on the implementation of the 1000 row 
              limit on SAS tables) 
Comments: To: Kevin Myers <KevinMyers@AUSTIN.RR.COM> 
 
Kevin Myers wrote: 
> P.S. - Being a 20 year veteran SAS user and consultant, a former SAS  employee, and 
a Certified SAS Developer, of course I realize only too well that SAS has all sorts 
of great features and capabilities that products like Excel and Access can't even 
remotely begin to compete with.  But it's very difficult to show someone else what a 
great product SAS really is when you can't get 'em past the initial 1000 obs limit 
stumbling block imposed by LE! 
 
Have a look at DBMS/Analyst, which comes with DBMS/Copy. DBMS/Analyst provides a near 
clone of the SAS data step syntax and of the most often used analytical procedures in 
Base SAS. Plus it reads and writes many different data formats (including SAS 
datasets), so it is like having SAS/ACCESS for * on steroids as well. And no obs 
limits, and no expiry date. Apart from being a useful tool in its own right (eg where 
you want to perform data manipulation using SAS syntax but SAS is not available), it 
is probably a better way to introduce others to the utility of SAS than struggling 
with the arbitrary limits and omissions in SAS LE. Oh, you also get DBMS/Explorer, a 
low-end but useful interactive data exploration package, thrown in for free with 
DBMS/Copy and DBMS/Analyst. 
 
DBMS/Copy plus DBMS/Analyst plus DBMS/Explorer costs a bit more than SAS LE - RRP of 
US$295 versus US$125 for SAS LE - but at least you are not shelling out for 
handicapware. There is also a demo version of DBMS/Copy and DBMS/Analyst, which is 



limited to just 100 obs, but at least it is free, which is what SAS LE should be, 
methinks. 
 
See http://www.conceptual.com for more information on DBMS/Copy and DBMS/Analyst. BTW 
I don't have any connection with Conceptual except as a satisfied customer. 
 
Tim C 
 
> ----- Original Message ----- 
> From: "Kevin Myers" <KevinMyers@AUSTIN.RR.COM> 
> Newsgroups: bit.listserv.sas-l 
> To: <SAS-L@LISTSERV.UGA.EDU> 
> Sent: Saturday, July 20, 2002 5:07 PM 
> Subject: SAS LE (Re: Confused on the implementation of the 1000 row limit on 
> SAS tables) 
> 
>>I too recently purchased and am evaluating SAS LE.  You can create large tables to 
your heart's content, but you just can't READ more than 1000 observations from any 
single table at once.  Yeah, there are some ways that you could probably get around 
that to some degree, but it could get really ugly if anyone tried to actually 
accomplish very much that way.  Besides, there are lurkers at SAS who monitor this 
newsgroup.  Lets not give them any reason to cripple this product more than it 
already is!!! 
>> 
>>Personally, I sure think that SAS should do something more along the lines of 
Oracle's (free!!!) Personal Edition.  With Oracle Personal, you can create any size 
tables that you want.  It's only Oracle's more advanced "enterprise" and "server" 
class features that are limited or disabled, such as parallel tasking (hence you are 
encouraged to get the real thing if you need to process lots of data quickly), 
multiple user-remote access capabilities, Internet publishing, and stuff like that. 
 
>>Unfortunately, I don't think that SAS is really going to accomplish very much at 
all with a product that is limited to only reading 1000 rows at a time.  There just 
aren't going to be enough folks out there who will be willing to take the time to 
"play around" with SAS such an unusable level, especially if they are going to have 
to spend any money to do so.  SAS needs to make the product realistically useful for 
some real work before most people are going to bother spending any money at all for 
it.  And, SAS had better do that if they want to have any hope at all of increasing 
their loyal customer base through this approach. 
>> 
>>LE is more like a demo than a real product.  I would have much rather seen SAS come 
out with limited subsets of Base, Stat, Graph, Access (PC products only), FSP, AF, 
and Connect (local host only), (no Share, no EIS, no Internet), with no size 
limitations for something on the order of $500 (competitive with Microsoft Office 
products, for example).  Even a yearly renewal on something like that would probably 
be ok.  Another possibility ***might*** be to release older versions (e.g. 6.12?) at 
a very substantially reduced price, with zero or limited support.  That way users 
could get a lot done, but would still be encouraged to spend money for new features.  
Even just a larger obs limit on LE as is would sure help a lot (say 100K obs?).    
Geez, even my 5 year old version of Excel can handle 64K 
rows at once!  And of course MS Access has no such limitations.  How can SAS afford 
to let their product (LE or not) look so bad in comparison?  You just can't do much 
of anything really useful with only 1000 obs, and I sure hope some other folks out 
there will provide some similar feedback. 
>> 
>>On the other hand, it's actually great that SAS finally came out with SOMETHING 
along the lines of LE.  At least they're making a little bit of progress... 
>> 
>>My $.02 worth. 
>> 
>>Kevin M. 
>> 
>>P.S. - My installation of LE seemed to go without a hitch at first. 
>>However, no icons for SAS, EG, or anything else were created in my start menu.  
There was just an empty "The SAS System" folder.  So, I created my own shortcut to 
start SAS.  But I wonder what other shortcuts were supposed to be in there, along 
with corresponding properties, etc? 
>> 
>>----- Original Message ----- 



>>From: "Roger DeAngelis" <xlr82sas@AOL.COM> 
>>Newsgroups: bit.listserv.sas-l 
>>To: <SAS-L@LISTSERV.UGA.EDU> 
>>Sent: Saturday, July 20, 2002 2:59 PM 
>>Subject: Confused on the implementation of the 1000 row limit on SAS tables 
>> 
>>>Hi All, 
>>> 
>>>305    data z; 
>>>306     set tst tst2; 
>>>307   run; 
>>> 
>>>NOTE: There were 1000 observations read from the data set WORK.TST. 
>>>NOTE: There were 1000 observations read from the data set WORK.TST2. 
>>>NOTE: The data set WORK.Z has 2000 observations and 3 variables. 
>>>NOTE: DATA statement used: 
>>>      real time           0.09 seconds 
>>>      cpu time            0.09 seconds 
>>> 
>>>Is it up to the honesty of the user to restrict the creation of tables 
>>>with more than 1000 obs, or was SAS suppose to implement changes 
>>>to prevent users from creating tables with more than 1000 obs? 
>>> 
>>>I cannot be reached by email or post to SAS-L, Mon-Fri, so please 
>>>respond to the list. I also do not have access to SAS LE Mon-Fri. 
>>> 
>>>So far I have spent less that 4 hours working with SAS LE. 
>>> 
>>>No I am not on weekend release from the US prison system. 
>>>However, I am working out of town. 
>>> 
>>>TIA 
>>>Roger DeAngelis 
>>>xlr82sas@aol.com 
>>>xlr82sas@hotmail.com 
>>>//members.aol.com/xlr82sas/utl.html 
>>> 
>>>NOTE: Copyright (c) 1999-2001 by SAS Institute Inc., Cary, NC, USA. 
>>>NOTE: SAS (r) Proprietary Software Release 8.2 (TS2M0) 
>>>      Licensed to The SAS Learning Edition V1.0, Site 0042234001. 
>>>NOTE: This session is executing on the WIN_PRO  platform. 
>>> 
>>>305    data z; 
>>>306     set tst tst2; 
>>>307   run; 
>>> 
>>>NOTE: There were 1000 observations read from the data set WORK.TST. 
>>>NOTE: There were 1000 observations read from the data set WORK.TST2. 
>>>NOTE: The data set WORK.Z has 2000 observations and 3 variables. 
>>>NOTE: DATA statement used: 
>>>      real time           0.09 seconds 
>>>      cpu time            0.09 seconds 
>>> 
>>>proc contents data=z; 
>>>run; 
>>> 
The SAS System 
 
The CONTENTS Procedure 
 
Data Set Name: WORK.Z                                 Observations:  2000 
Member Type:   DATA                                   Variables:     3 
Engine:        V8                                     Indexes:       0 
Created:       15:23 Saturday, July 20, 2002          Observation Length:   24 
Last Modified: 15:23 Saturday, July 20, 2002          Deleted Observations: 0 
Protection:                                           Compressed:     NO 
Data Set Type:                                        Sorted:     NO 
Label: 
 
 



     -----Engine/Host Dependent Information----- 
 
Data Set Page Size:         4096 
Number of Data Set Pages:   13 
First Data Page:            1 
Max Obs per Page:           168 
Obs in First Data Page:     115 
Number of Data Set Repairs: 0 
File Name:                  d:\work\_TD1112\z.sas7bdat 
Release Created:            8.0202M0 
Host Created:               WIN_PRO 
 
-----Alphabetic List of Variables and Attributes----- 
 
#    Variable    Type    Len    Pos 
----------------------------------- 
1    i           Num       8      0 
3    type        Char      5     16 
2    x           Num       8      8 
 

 
From:         Kevin Myers <KevinMyers@AUSTIN.RR.COM> 
Subject:      Re: SAS LE (Re: Confused on the implementation of the 1000 row 
              limit              on SAS tables) 
 
Hi folks - 
 
On further thought, I'm afraid that I may have offended some of the more sensitive 
and well-meaning souls at SAS with the perhaps inadvisable choice of wording in my 
last email on this subject.  Though it is true that I'm quite frustrated with the 
1000 obs limit and the lack of viewtable in SAS LE, I only meant the specific choice 
of words that I used in fun, and must apologize if I hurt anyone’s feelings by 
stating my opinions on this subject quite so strongly.  I still stand behind my 
opinions on this matter for all of the reasons that I listed in prior postings, but 
I'll try not to get quite as carried away with my wording in the future. 
 
As others including myself have previously noted, it IS nice that SAS released LE at 
all, even if it isn't everything that I believe it ought to be. 
 
Kevin M. 
 
 
From:         Don Henderson <donaldjhenderson@HOTMAIL.COM> 
Subject:      Re: SAS LE (Re: Confused on the implementation of the 1000 row 
              limit on SAS tables) 
 
Please permit me my 2 cents worth. 
 
Let us remember that SAS intended market for this particular product was not the 
folks who are on this list. Here is an extract from the SAS web site: 
 
. . . . . . perfect tool for you to discover the power of SAS. . . .  .  . . 
 
While I would not describe it as perfect, the key word here is "discover."  This 
product was intended to allow folks (e.g., students) who do not have SAS, and cannot 
get access to it, to get some exposure to the product so that they might be able to 
develop some SAS skills. I can't comment on whether LE is going to be successful in 
that market because I already know SAS, as do most of the folks on this list. 
 
So while the comments posted here by experienced SAS folks are certainly 
understandable, I hope that SAS concentrates its efforts on making sure LE will 
enable folks who don't know SAS to get some experience with it. The more folks who 
know about SAS and can use it, the better. And this tool will hopefully enable that. 
 
Regards, 
Don Henderson 
 
p.s., I do agree that perhaps Viewtable should have been included - or at least some 
tool to view a table of data. Perhaps it could be offered in tandem with the SAS 
Viewer (which can be freely downloaded from the SAS site). 



 
Date:         Thu, 25 Jul 2002 17:10:20 -0400 
From:         Diana Noble <diana.noble@PRUDENTIAL.COM> 
Subject:      SAS LE - observation 
 
I was very happy to pay for my copy of SAS LE because I thought it would provide me 
with an inkling of SAS version 7.x +.  Besides, I needed a cheap at home tool for 
tinkering without doing any real work on my own time. When the materials arrived, the 
literature seemed to indicate that this product would somehow be an apt learning tool 
for someone who wanted to earn a living with SAS. 
 
After reviewing the product and read along program, I began to wonder what type of 
entry level positions this SAS LE training would actually prepare one for.  The 
product seemed a bit like a lite version of a ms "works"-like program (especially the 
opening prompt to either work on a new project or an existing one).  Certainly 
someone well versed on desktop PC database or spreadsheet software would get a feel 
for the usefulness of the "power of SAS".  Perhaps this was the main intent. 
 
If someone wanted to seriously learn SAS in order to obtain gainful employment, it 
would seem to me that they would definitely need to have access to a SAS training 
class, and know how to recognize and deal with a more "SAS-like"(?) interface. 
Author: Fehd, Ronald J. 
Email: rjf2@CDC.GOV 
Subject:      Re: SAS/LE on Windows 
 
I've just installed SAS/LE on my PC running Windows 98. 
I prefer to do all my work in batch mode. 
How do I get sas/le to start up as a command and pass it a program name to run? 
 
Solution:  
-sysin is the parameter you want in this example dr0driver.sas is a program in 
SASinitialFolder 
 
-nosplash turns off the SAS logo while loading 
-sysparm can be used to pass a parameter to the program 
 
-config is necessary only if you have made changes to your configuration 
 
-altlog <filespec> and 
-altprint <filespec> are used if you want to save copies of your logs and listings 
 
to see your system configurations use 
-verbose 
which is not recommended for regular usage 
 
all this goes on one line w/out CR/LF. 
 
"C:\Program Files\SAS Institute\SAS\V8\sas.exe" 
-altlog u:\dls\SAS\altlog\rjf20001.log 
-config u:\dls\SAS\SASsite.cfg 
-SASinitialFolder u:\dls\MPEP\HIV1\p2002_07\pgm 
-sysin dr0driver 
-nosplash 
-sysparm SYSparmValue 

-verbose 
SN-008439  
IMPORT/EXPORT procedures and wizards not supported in SAS Learning Edition 

 
 
URL for this is: http://support.sas.com/techsup/unotes/SN/008/008439.html 
 

 
   Attempting to execute PROC IMPORT or PROC EXPORT in the SAS Learning 
   Edition, produces the following messages: 
  
     ERROR: Named item not found in list. 



     Arguments passed to GETNITEML: 
       1 APPLLIST = 4 
       2 APPLNAME = 'T8' 
     Program returning prematurely at line 179 
     AF Program: SASHELP.FSP.AFCLASS.SCL 
     APPLID = . 
     APPLLIST = 4 
     APPLNAME = 'T8' 
     ARGL = . 
     ARGLIST = . 
     CLIENT = . 
     DELETE = '' 
     DESCRIBE = '' 
     DESCRIPTION = 'Own Description' 
     ENVLIST = 2 
     EXIST = . 
     _ERROR_ = . 
     _MSG_ = '' 
     _self_ = 4913 
     _STATUS_ = ' ' 
     NOTE: Export Cancelled. 
     NOTE: The SAS System stopped processing this step because of errors. 
  
   This is because both the Import/Export wizards and procedures need 
   certain parts of SAS/AF to work, and SAS/AF is not included with SAS/LE. 
   The only way of importing a "CSV" file in SAS/LE is to use the Import 
   task in the SAS/LE's front end, Enterprise Guide. 
   In Enterprise Guide you can do the following to import your "csv" 
   file... 
  
   Tools > Import Data > Text Files...(follow the prompts from there) 
  
   The only other option is to use a data step in the editor window of 
   SAS/LE. 
  
   To Export to a "CSV" file, you will need to do the following... 
   File > Save As...(choose a "CSV" file type) 

 
Product: SAS Learning Edition  
Component: General Product Issues 
Priority: HIGH  
Note Type: Usage Issue  
Date: Tue, 1 Apr 2003 

Operating System and Source Fix Information 

System Release Reported Release Fixed
Windows NT  1.0     
Windows 2000 Datacenter Server  1.0     
Windows 2000 Professional  1.0     
Windows 2000 Server and Advanced Server 1.0     
Windows 95  1.0     
Windows 98  1.0     
Windows ME  1.0     
Windows XP  1.0     

Unless otherwise stated above, no fixes are available for this issue.  



 
SN-009833  
In SAS/LE, "ERROR: Module SASZAF not found in search paths" error message 
appears when trying to view dataset in SAS Explorer window  

 
 
   In SAS/LE, when you try to view a SAS dataset in the Explorer window, 
   the following error message appears: 
  
      ERROR: Module SASZAF not found in search paths. 
  
   This message appears because the Viewtable window that SAS uses 
   from the SAS Explorer shares modules with the SAS/AF product. 
   SAS/AF is not included in the SAS/LE product. 
  
   However, an interactive Report viewer exists within SAS/LE that allows 
   you to view datasets interactively. To use the Report viewer within 
   SAS/LE, from the menu bar, select Tools>Report Editor and select the SAS 
   dataset. 

 
Product: SAS Learning Edition  
Component: General Product Issues 
Priority: N/A  
Note Type: Usage Issue  
Date: Tue, 6 May 2003 

Operating System and Source Fix Information 

System Release Reported Release Fixed
Windows NT  1.0     
Windows 2000 Professional 1.0     
Windows 98  1.0     
Windows ME  1.0     
Windows XP  1.0     

Unless otherwise stated above, no fixes are available for this issue.  



 
SN-009827  
SAS/LE on Windows 98 needs service pack 1 or Windows Second Edition 

 
 
   To install SAS/LE on a Windows 98 machine, you need to have Windows 98 
   service pack 1 or Windows 98 Second Edition installed on the machine. 
   This is a minimum requirement for using SAS 8.2, which is the release of 
   SAS that SAS/LE uses. 
  
   Download the Windows 98 service pack 1 or the Windows 98 Second Edition, 
   following location: 
  
      http://www.microsoft.com/windows98/downloads/ 

 
Product: SAS Learning Edition  
Component: General Product Issues 
Priority: N/A  
Note Type: Usage Issue  
Date: Tue, 6 May 2003 

Operating System and Source Fix Information 

System Release Reported Release Fixed
Windows 98 1.0     

Unless otherwise stated above, no fixes are available for this issue.  

Submitted by Don Tedesco 
 
In SAS/LE, when you try to view a SAS dataset in the Explorer window, 
   the following error message appears: 
  
      ERROR: Module SASZAF not found in search paths. 
  
   This message appears because the Viewtable window that SAS uses 
   from the SAS Explorer shares modules with the SAS/AF product. 
   SAS/AF is not included in the SAS/LE product. 
  
  
To view the data in LE, you can use the programming route which you have already 
found by using a series of Proc Print, or: 
 
" 
However, an interactive Report viewer exists within SAS/LE that allows 
   you to view datasets interactively. To use the Report viewer within 
   SAS/LE, from the menu bar, select Tools>Report Editor and select the SAS 
   dataset. 
" 
 
This is taken from http://support.sas.com/techsup/unotes/SN/009/009833.html. 
 



product = SAS Learning Edition 
    011778 "SASIMLW not found in search paths" error message appears when you try 
           to invoke SAS/IML in SAS Learning Edition 
    Component:  General Product Issues 
    Release(s) Reported: 1.0 
    Release(s)    Fixed: 
    SN     http://support.sas.com/techsup/unotes/SN/011/011778.html 
 
    011065 Correcting SAS Learning Edition installation and invocation error 
           messages "Cannot create a copy of the datasource" and "Cannot connect to 
           the local server" (Section I) 
    Component:  General Product Issues 
    Release(s) Reported: 1.0 
    Release(s)    Fixed: 
    SN     http://support.sas.com/techsup/unotes/SN/011/011065.html 
    011066 Correcting SAS Learning Edition installation and invocation error 
           messages "Cannot create a copy of the datasource" and "Cannot connect to 
           the local server" (Section II) 
    Component:  General Product Issues 
    Release(s) Reported: 1.0 
    Release(s)    Fixed: 
    SN     http://support.sas.com/techsup/unotes/SN/011/011066.html 
 
    011666 SRW balks on Microsoft Runtime Components when installing SAS Learning 
           Edition 
    Component:  General Product Issues 
    Release(s) Reported: 1.0 
    Release(s)    Fixed: 
    SN     http://support.sas.com/techsup/unotes/SN/011/011666.html 
 
product = SAS Learning Edition 
    008404 How to install SAS Learning Edition on a system that has a previous 
           release of SAS already installed 
    Component:  General Product Issues 
    Release(s) Reported: 8,8.2 
    Release(s)    Fixed: 
    SN     http://support.sas.com/techsup/unotes/SN/008/008404.html 
 


